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Digital printing vs. offset printing

Printing
concept

Cost to
reproduce

Time to set
up

Quality of
reproduction

Digital printing process

Digital printing can be an economical choice if
you want smaller quantities (500-2000
sheets). If you need a lager quantity, the costs
can become higher than offset printing.

As the major setup requirements for a digital
press includes adding paper and ink carriers,
the digital press can generally be ready faster.

Digital printing can provide an acceptable
reproduction that meets the needs of many
types of printing requests. It can, however,
have limitations in resolution output (generally
600 dpi).

Offset printing process

Offset printing can be more
expensive due to press setup.
Costs associated with plate
production, press make-
ready time (mounting plates,
registration adjustments,
setting ink keys), can elevate
the cost of reproduction.

If large quantities are
required, however, once an
offset press is set up, offset
printing can offer an overall
lower cost.

As the major setup required
to prepare a press between
press runs includes washing,
set up and alignment, offset
printing setup time generally
takes longer compared to a
digital press setup.

Offset printing can produce a
higher resolution output
(generally 1200-2400 dpi).
The higher the resolution, the
finer the image quality.



Color

Speed of
printing

Proofing

Paper

Strengths

Digital color printers use a four color process
that can include additional colors to widen the
color gamut. Some digital printers, however,
have limitations in brightness, saturation, and
the range of colors available, for example
PANTONE colors, metallic and fluorescent inks.
There can also be limits to special treatments
such as varnishes.

Overall speed is slow compared to offset.

A proof can be created on the same equipment
that the final job is printed on, therefore the
proof is accurate to the final piece.

Paper choice can be limited based on paper
thickness and size. Additional limitations are
related to finishing choices (embossing,
stamping, die-cutting, special folding needs).

Economical for short run jobs

Less time for press setup

Scheduling keeps press continually working
Less waste

Accurate proofing process

Enables Variable Data Printing

Offset printing uses a four
color process but can allow
for a wider selection of
additional colors (PANTONE
spot colors).

In comparison to some digital
printers, offset can offer
better color control which
results in better color
reproduction.

Overall speed is very fast
once setup is complete.

Proofing can be inaccurate
depending on the type of
proof created and the type of
press the job is printed on,
therefore, results may be
inconsistent.

A large selection of paper can
be used for offset printing. A
wide range of paper
thicknesses, textures, and
sizes can be selected,
including the use of a
multitude of finishing
techniques.

® Economical for long run
jobs

® Can display higher quality
output vs. digital printing

® Has greater reproduction
abilities (greater color
spectrum, accepts wide
range of paper substrates,
allows for wide range of
finishing techniques



Challenges

Not economical for long runs ® More time for press setup
® Can display quality limitations ® |onger turn-around time
® Can have reproduction restrictions (color ® Not economical for short

spectrum, paper size/thickness, finishing runs

techniques) ® More waste

® Can't meet Variable Data
Printing needs

Digital print growth has mainly taken place in these areas:

Fast turn-around times
Short run jobs

Print on Demand
Variable-Data Printing

Digital printing workflow scenarios

There are a variety of workflows that can be utilized in a digital environment. The following
scenarios provide examples of digital printing workflows.

Scenario 1: Pure digital using Variable-Data Printing (VDP)

Job description:

The job is an 8-page personalized brochure. The brochure uses CMYK throughout and uses a
different cover paper stock compared to the body stock. Both the cover and body pages are to
be reproduced on a digital press.

Process:

A variable design template is first created by a prepress department. The output of the template
is proofed and approved by the customer using the sample data. Using a web portal, the
customer uploads the data file that will drive the personalization of the brochure. A Customer
Service Representative downloads the data file, and the prepress department composes the VDP
output file using the data provided. The VDP output composition is then sent to the digital front
end for ripping, imposition, and print output. As each printed piece is unique, production staff
must keep the output in order and reprint any pieces that could be damaged.

Scenario 2: Hybrid workflow

Job description:

The job is a 400-page textbook plus cover. The front cover uses CMYK process color and the
body pages are black only. The covers are to be printed in advance on an offset press and
stored on an as needed basis. The textbook body is to be reproduced on a print on demand
basis using a digital press. The print buyer has just requested 200 textbooks to be printed.
Process:

Input files are added from a stored location and added to a digital press workflow. PDF pages
are imposed using the digital front end associated to the digital press. At completion of the
digital printing process, books are bound with the pre-printed offset covers.



Scenario 3: Pure offset workflow using digital print for content proofing

Job description:

The job is a 32-page booklet plus cover. The front cover uses CMYK process color and two spot
colors. The body pages use CMYK process color and one spot color. The customer has requested
5,000 booklets to be produced. The job is to be run on an offset press with content proofs
generated on a color digital press.

Process:

Input files are added to a prepress workflow, imposed, and prepared for output. Prior to making
plates, pages are output to a digital press for content proofing purposes. Following approval of
the digital proof, plates are made and the job is printed on an offset press.

Digital printing and JDF technology

Job Description Format (JDF) is an industry standard format designed to simplify the
information exchange between different applications and systems in and around the graphic arts
industry.

JDF technology provides a method to describe the entire lifecycle of a print job from start to
finish, including a detailed description of the prepress, the final output device, postpress, and
delivery processes.

JDF-enabled digital presses
JDF templates and job tickets
JDF digital press front end
JMF-enabled digital presses

JDF-enabled digital presses

JDF digital printers have the ability to execute printing instructions sent to them in JDF or other
forms of job ticket descriptors. JDF templates or job tickets instruct how a job is to be printed
including colors to use, size of paper, type of paper, page layout, bindery information etc.

JDF digital printers essentially support JDF templates/job tickets based on:

® Remote job ticketing—eliminates having to physically walk to a digital press front end to
manually set up a job ticket.

® Job submission and tracking—supports job ticket submission to a digital press front end
and allows a job to be tracked throughout the printing process.

JDF templates and job tickets

Digital JDF templates and job tickets describe how a job is to be printed. This information
includes print parameters such as orientation, two-sided printing settings, offset selections and
trim sizes. Additional information can include paper stocks to use, how marks are to be
positioned, how color is to be rendered, and how the final product is to be finished. JDF
templates/job tickets work as remote instructions for a print job.

JDF digital press front end



A JDF digital press front end is a component of a JDF workflow that initiates devices, routes JDF
messages, and communicates status. JDF front ends have the ability to read job ticket
instructions for each job and process the job accordingly. A JDF front end may be embedded as
part of the press, may be a separate physical device, and could be in control of more than one
press.

JMF-enabled digital presses

Job Messaging Format (JMF) works as the communication format that facilitates interaction
between various aspects of a JDF workflow.

JMF communication creates a more automated method of submitting files between a Prinergy
system and a digital press, and creates a bi-directional communication link that allows Prinergy
to display direct feedback from the press.

Prinergy also supports non-JMF-enabled presses; however, these presses need to use an
alternate submission channel, and cannot provide Prinergy with direct status information.

What is Prinergy Digital?

Prinergy Digital is a production tool that communicates with a variety of digital press front ends
to schedule, submit, and monitor the printing of multiple documents in a digital printing
environment.

What features does it support?

Prinergy for digital printing concepts

What are Digital Submit and Digital Direct?
Who uses Digital Submit?

Creating and submitting digital print jobs
Digital Direct

About lists

About document status types

About the press window

Who uses Digital Direct?

A Prinergy for digital print environment

Submission methods used in a Prinergy for digital print environment

What features does it support?

® Remote Job Ticketing—eliminates having to physically walk to a press to manually set up a
job ticket and submit a job. Facilitates an uninterrupted flow of jobs that can be initiated
by multiple operators at the same time.

® Centralized Repository—stores job files in a centralized location that can be accessed by
all. Can also provide file management options such as archiving.

® Job Messaging Format Capabilities—provides press status and feedback information
through Prinergy Workshop.

® Supports Rules-Based Automation (RBA)—allows for automatic job processing and digital
print job ticketing through RBA.

Prinergy for digital printing concepts



A Prinergy for digital printing workflow can be described using five basic concepts:

1. Upload documents
Input files are submitted to Prinergy Digital Print. A Prinergy job is created, and content
files and a JDF template or job ticket are uploaded to the digital print management system
(Digital Direct) as documents.

2. Manage documents
Documents are organized or sorted based on a manual or automated process. Managing
documents helps sort large numbers of documents received on a daily basis, and is
important for scheduling purposes.

3. Plan documents
Planning involves setting document priorities and scheduling digital press use for
maximum productivity.

4, Submit documents
Documents are submitted and placed into an active state to be RIPed and printed. At
completion, documents are moved to a completed or done state.

5. Remove documents
At completion of the printing process, documents can be archived and removed from the
system. This helps manage the large number of documents entering and moving through
the system.

To help you understand the concepts of a Prinergy for digital print workflow in more detail, the
following example provides a fundamental representation of the workflow, including software
and process terms used.

Digital Submit Prinergy Job

> % -
Digital Direct
4, = 5_:5;;,,.? 5. Digital Front End
ﬂl £ ) Digital Press
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1. Aninput file (PDF, PS, DCS, VPS, PPML) is submitted to a target press using Digital
Submit.

2. A Prinergy job name is selected and a JDF template or job ticket is identified (contains
print instructions). The input file and JDF template/job ticket are then submitted to the
Prinergy Digital Print system.

3. A Prinergy job is created and the input file and print instructions are combined into a
document. The document is uploaded to Digital Direct.

4. In Digital Direct, the document is sorted, planned, and submitted to a digital press.



5. The digital press front end prepares the document (RIPs the file) and then submits it to a
digital press to be printed. At completion, the front end updates the document status in
Digital Direct and the document is then archived and/or removed from Digital Direct.

Important: The example above represents a basic workflow. Based on submission processes
used (Digital Submit vs. Workshop), the number of input files submitted (single vs. multiple),
and the number of presses selected (one vs. multiple presses), steps in the workflow can vary.
The main workflow sequence, however, remains the same.

Helpful definitions

Content file—An input file (PDF, PS, DCS, VPS, PPML), imposition plan, or multiple PDF pages
Document—A document contains content file data and printing instructions. In Digital Direct, a
document is managed independently. If a Prinergy job contains two documents, each document
is managed separately. In Digital Direct, a document could also be considered a digital job.

What are Digital Submit and Digital Direct?

Digital Submit and Digital Direct manage the production of multiple documents that move
through a digital printing environment on a daily basis.

Digital Submit

Digital Submit software is used to create Prinergy jobs, combine content file information and
printing instructions into a document, and upload the document to the Prinergy Digital Print
system.

Digital Submit window

The Digital Submit window lists the digital presses and automated production targets that you
can submit content files to.

All listed digital presses and automated production targets are generally set up by your system
administrator. The targets that are listed are arranged based on your workflow system and
business needs, such as the different types of digital presses that you have, or if your system
includes automation.

Content files can be submitted in one of two ways:

® Directly to a digital press

The targets that are listed under the Digital Presses section are associated to digital presses in
your environment. Choosing a target press will queue a document to be manually planned and
submitted to a specific press

® Directly to an automated production target

The targets that are listed under the Automated Production section have Rules-Based
Automation (RBA) rules associated with them. These rules include pre-defined job parameters
that automatically move content files through the system.
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Who uses Digital Submit?

Digital Submit software is designed primarily for customer service representatives or individuals
who receive customer orders to be printed. These users know which type of digital press or
automated production rule to target a job to based on the type of job and the printing
requirements. Digital Submit allows users to create Prinergy digital print jobs without having to
use Workshop.

Creating and submitting digital print jobs

The following steps outline the basic procedures used when submitting content files to Digital
Submit:

1. A content file is dragged to a target digital press or automated production target (RBA
rule) listed in the Digital Submit window.

2. Prinergy job selections are made that include a Prinergy job name, printing instructions,
and print quantities. The content file is then submitted.

3. The Prinergy system creates a job, combines the content file information and printing
instructions into a document, and uploads the document to be printed by a target digital
press.

When submitting to a target press or automated RBA rule, you are:

® Creating a Prinergy job
® Uploading documents to Digital Direct
® Targeting the documents to be printed by a specific digital press
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When a content file is dragged to a digital press or an automated production rule in Digital
Submit, a New Job Submission dialog box opens. Here, information is entered that includes
the name of the Prinergy job, the JDF template or job ticket to use (printing instructions),
print quantities, and shipping information.

When the Submit button is selected, a Prinergy job is created and the document is
uploaded to Digital Direct.
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Depending on how the content file was submitted to Digital Submit, the document could
follow one of two possibilities:

¢ If submitted to a target press, once uploaded to Digital Direct, the digital press operator
manually prioritizes and submits the document to be printed to a target press.

® If submitted to an automated production rule, once uploaded to Digital Direct, the
document is automatically printed to a target press.



Digital Direct

Note: Digital direct is only used to monitor and control older digital press connections. Newer
digital presses, such as Ricoh and Konica Minolta, uses the TRACK module for queue
management and monitoring. TRACK is also compatible with older digital presses.

Digital Direct is used to manage multiple documents and digital presses in a digital printing
environment.

Digital Direct manages and queues documents to be printed during a shift, determines how
many hours of printing are required for each digital press, and provides flexibility to change
printing submissions if required.

Digital Direct window

The Digital Direct window allows you to work with different types of lists that help organize
multiple documents and efficiently queue jobs to digital presses.

DoclLists are used for manually sorting documents into groups for specific purposes, for
example, sorting "documents that need to be printed during the second shift".

Smart Doclists are used to automatically sort documents based on specific criteria that you
select. For example, you might need to create a list of documents that can only be printed by a
specific digital press or using a particular media type.
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The Digital Direct window includes the following information and functionality:

® Available Presses, Smart DoclLists and DoclLists are located in the left pane. The status
of a press can be viewed in this pane.

® When Digital Direct is opened, the default view is Ready to Print. The Ready to Print view
displays all documents that have yet to be planned or submitted to press. You can click
columns to change the sorting order. Columns can be controlled using the menu item View
> Visible Columns.
If you want to view every job in the system, select All Documents.
In the lower left corner of the window, buttons are available to create and delete lists.

About lists

DoclLists and Smart DoclLists are use to organize large numbers of documents entering the
system, and can greatly assist in the digital press scheduling process. You can create as many
document lists as required. Every list will be available to any user on the system.



The left side of the Digital Direct window displays all document list types available. These lists
include:

® All Documents list

Contains all documents that are in the system, including documents that are "On Press" or have
"Completed" printing. Any document that has been created using Digital Submit is automatically
added to this list. This list can't be deleted or modified.

® Ready to Print list

Contains all documents that are not yet printed. By default, this list is automatically displayed
when you open Digital Direct. This list can't be deleted or modified.

® Doclists

Doclists are used to manually organize or sort documents in a production environment. DocLists
are first created using pre-determined names, and then documents are dragged to the
appropriate DoclList based on how they are to be organized. For example, you can create a
DoclList to group a random collection of documents that need to be printed by the end of the
day. You could then delete the DoclList after all documents have been printed. The following
examples could be used as DoclList names:

Print on Monday before noon

Print on Monday between 1 pm and 5 pm
Print on Tuesday

Print on Wednesday

Rush Jobs

Smart DoclLists

Smart DoclLists
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Smart DoclLists use customized criteria to automatically sort documents entering the Prinergy
Digital Print system. A Smart Doclist displays all documents that match the criteria that you set
up for that list. Documents are automatically added to a Smart DocList when they match the
criteria, and are automatically removed when they no longer fit the criteria. The following
examples identify criteria that could be used as part of a Smart DocList name:

Specific press name

Jobs to print today

Variable data jobs

Jobs in error

Jobs over 4 hours of printing
FedEx jobs for today
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About document status types

The status of a document is indicated by a status indicator. The indicator changes as the
document moves through the system.

® Ready to Print—indicates that the document is ready to print.
® Planned—indicates that the document has been scheduled to print.
® On Press—indicates that the document is printing.



® Post Press—indicates that the document is finished printing, but additional processing is
occurring (such as bindery processes).

® Completed—indicates that the document has finished printing and any additional
processing.

® Removed—indicates that a document has been deleted or removed from a digital press
via its front end software.

About the press window

Use the press window to view the status of a digital press and to manage documents that you
want to print.

In the Digital Direct window, a list of presses that have been configured for your printing
environment is displayed in the left pane. The icon beside the name of the press indicates the
status of the press.

When you manage documents on the digital press, the information that is displayed depends on
the digital press and front end that you are using.
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Press window status
In the press window, documents move from a status of Ready to Print to Planned, Active,
and Done or Storage.

® Planned tab—displays a list of documents that you plan to submit to the press in the next
print run.

® Active tab—after a document is submitted, it becomes an active document. You can view
the progress of the document as it is being printed.

® Done or Storage tab—after a document is finished printing it is displayed in the Done or
Storage tab, depending on the type of digital press or front end that you have.



Who uses Digital Direct?

The Digital Direct software has been designed to be used by digital press operators responsible
for managing documents and digital presses in a digital printing environment.

A Prinergy for digital print environment

® Using Prinergy Workshop
® Using Rules-Based Automation
® Monitoring documents in a digital print environment

Using Prinergy Workshop

When large numbers of documents need to be effectively managed in a digital environment, it
isn't time effective to manually create a new job in Workshop for every document to be printed.
To save time, a Prinergy job is automatically created when input files are submitted to Digital
Submit (to a digital press or RBA rule), or submitted using an RBA rule.

Workshop essentially works "under the hood" to create jobs, store content files in a centralized
location, and provide file management options such as archiving. In most digital printing
workflows, Workshop isn't used as a production tool. If there are file errors or additional
prepress tasks required for a job, the job can be opened in Workshop and content files can be
corrected or edited as needed. Content files are then submitted back to Digital Direct and
scheduled for press.

Using Rules-Based Automation

Rules-Based Automation (RBA) software automates the submission process of content files to
the Prinergy Digital Print system. RBA rules can be used as a submission channel in Digital
Submit. Based on the needs of the submission process, RBA rules can be created to meet a
multitude of customized submission requirements.

Note: For more information about Rules-Based Automation, see the Rules-Based Automation
Self-Study Guide.

Monitoring documents in a digital print environment

Documents can be monitored as they move through the digital printing process in two ways:

® Using the Press view in Digital Direct
® Using the History view in Workshop

Submission methods used in a Prinergy for digital print environment

The following examples outline how a document could be submitted using various submission
methods.

A submission scenario using Rules-Based Automation (RBA), Workshop, Digital
Submit, and Digital Direct

A customer service representative (CSR) receives an input file from a customer and uses Digital
Submit to submit the file. The CSR can use either a target digital press or a target RBA rule to
submit the input file. A Prinergy job is created and the document is displayed in Digital Direct.
Using Digital Direct, the digital press operator will schedule the document to run at a certain
time on a digital press. Similarly, RBA rules can be configured to submit documents directly to a
digital press.

Submission process:



® Input file is submitted to Digital Submit (digital press or RBA rule).
® Digital Submit can also be used as a direct submission channel to Prinergy for offset jobs
(RBA rule).

A submission scenario using Workshop, Digital Submit, and Digital Direct

A CSR receives an input file from a customer and uses Digital Submit to submit the input file to
a digital press. A Prinergy job is created and the document is displayed in Digital Direct. Using
Digital Direct, the digital press operator schedules the document to run at a certain time on a
digital press.

Submission process:

® Input file is submitted to Digital Submit (digital press).
Using Prinergy for digital print

The following illustrates a digital workflow using Digital Submit and Digital Direct.

Drag an input file from a desktop or other location to a digital press or RBA rule in Digital
Submit. Alternatively, you can double-click a digital press or RBA rule and then add the input
file. If you want to use the File menu, you can select a target press or RBA rule and use File >
New Job Submission.
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In the New Job Submission dialog box, enter information that identifies the Prinergy job name,
input files selected, print instructions, quantities to print, and properties of the job. Then,
submit the job.
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Once the job is submitted, the Processing File Submission dialog box indicates when the job
submission process is complete. At completion, a Prinergy job is created and the input file
associated to the job and it's print instructions appear in Digital Direct as a document.

In Digital Direct, a digital press operator can organize or sort the document into a list (DocLists
or Smart Doclists). Alternatively, the document can be directly accessed from the Ready to
Print window.

ene [SmartDocList] Ready To Print (=]
Server: Nova { =g . .
User: AraxiLab é@ I:l’ n @ = Q- Description
Inspect Plan Submit Delete History Search
¥ PRESSES .
NexPress-sim-wl 3 ¥ Ready To Print
) nexpress-sim-w2 {3 Description: Shows all documents that are ready to be printed.
¥ SMART DOCLISTS S y: Show doci which match any of the following criteria:
lﬂ All Documents State is "Ready To Print"
E] Ready To Print or State is “Planned”
U e N, State Print Quantit: No. P. Target P
5] List from Nova ame : rin ntity . Pages rget Press
H Needs Attention Kodak Document_Wells Brochure ¥ Ready To Print 250 8 nexpress-sim-w2
(2] On Press StoryWorksDS5(st006__c2040.pdf) O Ready To Print 1 1 nexpress-sim-w2
(2] Print Today StoryWorksDS(st005__c2040.pdf) O Ready To Print 1 1 nexpress-sim-w2
3 R StoryWorksDS(st003__c2040.pdf) O Ready To Print 1 1 nexpress-sim-w2
StoryWorksDS(st004__c2040.pdf) O Ready To Print 1 1 nexpress-sim-w2
StoryWorksDS(st002__c2040.pdf) O Ready To Print 1 1 nexpress-sim-w2
StoryWorksD5(st001__c2040.pdf) O Ready To Print 1 1 nexpress-sim-w2

Once organized, the document status is changed to Plan for Press.
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Summary: Show documents which match any of the following criteria:

Remove from DocList

Name State Print Quantity MNo. Pages Target Press

Kodak Document_Wells Brochure Plan for Press 250 8 nexpress-sim-w2
StoryWorksDS(st006__c2040.pdf) Submit to Press 1 1 nexpress-sim-w2
StoryWorksDS(st005__c2040.pdf) 1 1 nexpress-sim-w2
StoryWorksDS(st003 __c2040.pdf) Change to Post Press 1 1 nexpress-sim-w2
StoryWorksDS(st004__c2040.pdf) Change to Completed 1 1 nexpress—sim-w2
StoryWorksDS(st002__c2040.pdf) o . 1 1 nexpress-sim-w2
StoryWorksDS(st001__c2040.pdf) Add to Doclist 1 1 nexpress-sim-w2

Once the document is planned, the target press is selected from the Presses list. In the Press
view, the document is prioritized and scheduled in the Planned tab. Once it is planned and
ready for print, the document status is changed to Submit to Press.

¥ NexPress: nexpress=-sim-w2

Press Status: @J

Media: Inks:

SterlingUltraDigitalGloss_118_12x18 @ Cyan

LustroGloss_118_12x18 [ Magenta
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& SterlingUltraDigitalGloss_118_350x470 @ Black
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—E [ IPlanned (1 doc, 58 minutes) | & Active (0 docs) + Done (0 docs)

Surfaces

000

MName

Kodak Document_Wells Brochure

Mo. Pages Mo, Copies

Submit to Press

Delete Document |
Remove From Plan | -

The submission process is monitored using the Active tab. The Active tab displays the RIPing,
submitting and printing information.

Press Status: @

¥ NexPress: nexpress=sim-w2

Media: Inks:

! SterlingUltraDigitalGloss_118_12x18 E Cyan

LustroGloss_118_12x18 Ii Magenta

LustroGloss_118_12x18 CJ Yellow

SterlingUltraDigitalGloss_118_350x470 W Black
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[EIPlanned (0 docs) | = Active (1 doc, 58 minutes) | <« Done (0 docs)

Print Duration Submitted
58 minutes Tomorrow 3:54 AM

Mame
Kodak Document_Wells Brochure

Progress
Printing b ™ 30/500




At completion of the printing process, the document appears in the Done or Storage tab, and
can be reprinted, or archived and/or removed. The name of this tab varies depending on the

type of digital front end used.

¥ NexPress: nexpress-sim-w2

Media:

& SterlingUltraDigitalGloss_118_12x18
& LustroGloss_118_12x18
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Supported digital presses

The following tables list all supported static and variable file format types based on the digital

press and digital front end used.

® (1) indicates highest functionality (preferred format)
® (2) indicates additional secondary format

The table below lists supported file formats for NexPress, Digimaster, and Versamark presses
using Kodak and Creo Color Server front ends.

Digital press

NexPress S2100/52500/S3000/M700 with NexPress front end
8.5 (minimum version) or 12 (recommended)

NexPress S2500/S3000/M700 with Creo Color Server running

NexPress Vcs front end 10.231

Digimaster with Digimaster front end 7.01
Note: Integration with Kodak SmartBoard Document Mastering

Static file
formats
supported

(1) JMF

(2) JDF hot
folder

(2) PDF hot
folder

(1) JMF

(2) JDF hot
folder

(2) PDF hot
folder

(1) LPR

Variable
file
formats
supported

(1) PPML
/VDX

(2)
Optimized
PDF/PS

N/A



software is required in order to create SmartBoard job tickets
and to enable connectivity.

Versamark VL2000 with Creo Color Server running Print
Manager 710

(1) JMF

(2) JDF hot
folder

(2) PDF hot
folder

The table below lists supported file formats for Xerox DocuTech, DocuPrint, and DocuColor

presses with Xerox, EFI Fiery, and Creo Color Server front ends.

Digital press

iGen3 with Creo Color Server running Spire 5.0.103 SP1

iGen4 with Creo Color Server running Xerox CX print server 1.0.
d292

DocuColor 7000/8000 with Creo Color Server CX 7000

Any other Xerox press with Creo Color Server running Spire or
Xerox CX print server

Xerox 5000/5252/6060/7000/7000AP/8000/8000AP/DocuPrint
B&W/DocuTech B&W/242/252/260 with Xerox running FreeFlow
(DocuSP)

Xerox 4112/4127, Xerox Color 550/560 Printer, Xerox Color 800
/1000 Press, Xerox DocuColor 242/252/260, Xerox DocuColor
6060, Xerox DocuColor 7000/8000, Xerox DocuColor 8000AP,
Xerox iGen3 90/110, Xerox iGen4 with EFI Fiery

Static file
formats
supported

(1) JMF

(2) JDF hot
folder

(2) PDF
hot folder

(1) JMF

(2) JDF hot
folder

(2) PDF
hot folder

(1) JMF

(2) IJDF hot
folder

(2) PDF
hot folder

(1) JDF hot
folder

(2) PDF
hot folder

(1) JDF hot
folder

(2) PDF
hot folder

(1) IMF

Variable
file
formats
supported

(1) VPS
(2) PPML
/GA

(1) VPS
(2) PPML
/GA

(2)
Optimized
PDF/PS

N/A

(1)
Optimized
PDF/PS



The table below lists supported file formats for the Hewlett-Packard Indigo presses with HP and

Creo Color Server front ends.

Digital press

HP 1050/3050/3500/5000/5500 with Creo Color Server running
Production Stream 1.2

HP 7000 with Creo Color Server running SmartStream or
Production Plus 1.0

HP 3050/3250/5000/5500/7000 with HP running Production Flow

HP 3050/3250/5000/5500/7000 with HP running HP Indigo
SmartStream Production Pro (minimum version 3.5,
recommended version 4.6, for Mac OS X 10.9 support use 4.6.4)
or HP Indigo SmartStream Onboard

Static file
formats
supported

(1) JDF hot
folder

(2) PDF
hot folder

(1) JMF

(2) JDF hot
folder

(2) PDF
hot folder

(1) JDF hot
folder

(2) PDF
hot folder

(1) JMF

(2) JDF hot
folder

(2) PDF
hot folder

Variable
file
formats
supported

(1) VPS
(2) PPML
/GA

(2)
Optimized
PDF/PS

(1) VPS
(2) PPML
/GA

(2)
Optimized
PDF/PS

(1) PPML
/GA

(2)
Optimized
PDF/PS

The table below lists supported file formats for the Konica-Minolta BizHub Pro presses with Creo
Color Server and EFI Fiery front ends (minimum EFI version is 9 R2; recommended version is

10).

Digital press Static file Variable file
formats formats
supported supported

Konica-Minolta bizhub PRO with Creo Color Server (1) JDF hot

running IC-301 folder
(2) PDF hot
folder

Konica-Minolta bizhub PRO with Creo Color Server (1) JMF

running IC-304 (2) JDF hot



folder

(2) PDF hot
folder
Konica-Minolta bizhub PRESS C7000/C6000, C8000, (1) JMF
with EFI Fiery
Konica-Minolta bizhub PRO C6500/C6501/C5501, (1) JMF
C65hc, ColorFORCE 8050 / bizhub PRO C500 with EFI
Fiery

The table below lists supported file formats for the Konica Minolta bizhub presses with Konica
Minolta front ends

Digital press Static file formats Variable file formats
supported supported

Konica Minolta bizhub PRESS C7000 (1) JMF

with IC-601 DFE (2) JDF hot folder

The table below lists supported file formats for the Canon and Ricoh presses with EFI Fiery front
ends (minimum EFI version is 9 R2; recommended version is 10).

Digital press Static file Variable file
formats formats
supported supported

Canon imagePRESS 1135/1125/1110, C1/C!+, C6000, (1) JMF
C6010, C7000VP/C6000VP, C7010VP/C6010VP with EFI Fiery

Canon imageRUNNER 5050/5055/5065/ 5075/7086/7095 (1) IMF
/7105, C3880 (Japan)/ 4080/4580/5180/5185 with EFI Fiery

Aficio Color 3260C/5560, Aficio MP C550EX/C700EX / Aficio (1) JMF
MP C6000/C7500, Aficio MP C6000/7500, imagio MP C6000
/7500 with EFI Fiery

Ricoh Pro 907EX/1107EX/1357EX, Pro C720/C720S, Pro C751 (1) JMF
/C751EX/C651EX, Pro C900/C900S, Pro C901/C901S with
EFI Fiery
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